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Getting Started

After unpacking your Dynamometer it will be necessary to connect it to 
the electrical supply and your computer. The Dynamometer is supplied 
with a standard 13 amp plug for use in the United Kingdom. For other 
parts of the world this should be removed and the appropriate plug fitted. 
The Dynamometer should be supplied with 200/220 volts 50/60 Hz a.c, 
unless it is three phase where the following diagram should be observed. 

The Dynamometer has an inrush current of 20 amps but when running 
should draw closer to 10 amps. This machine MUST be earthed. Your 
Dynamometer is connected to the computers serial or USB port utilizing 
the lead supplied.

 Your next task is to install the Dynamometer software onto your 
computer, if we have supplied the computer with the Dynamometer this 
will already be done.

 To install your software follow these steps:-

1. Either using the disk provided or software downloaded 
From the internet (www.spa-uk.co.uk) click on the zip 
file and select an appropriate place to extract the file.

2. When the file has extracted, double click on the setup icon 
commence the installation selecting your preferred installation 
path.
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1 Introduction

Congratulations on the purchase of your SPA Dynamometer. Your dyno has been designed

and built by engineers and craftsmen at SPA whose experience in data acquisition and race

car design has made them world leaders in shock dynamometer testing and technology.

This manual is intended to serve two purposes. Firstly, to get you started if you have never

used a Dyno before. Secondly, to show you the extra functions and facilities that have been

added to version 6 software for experienced users.

If you are a new user follow the step-by-step guide on operating the dyno and within a short

space of time your familiarity with the software will allow you to work on your shocks with

confidence.

If you have problems or queries, which cannot be solved by this manual or the help file then

technical support is available from: -

SPA Design

The Mill House

Packington Hayes

Tamworth Road

Packington

Nr. Lichfield

STAFFS

WS14 9PN

Phone (+44) 01543 434580

Fax     (+44) 01543 434581

Sales Enquiries sales@spa-uk.co.uk

Technical Enquiries dynamometers@spa-uk.co.uk 

Website                      www.spa-uk.co.uk 
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2 Dynamometers

SPA Design manufactures  a wide range of  shock testing  equipment  for  motorsport  and

automotive applications.  Shock dynamometers are used by engineers to perform a wide

range of tests from simple conformity tests to full characterisation of shock performance. The

range  of  shock  dynamometers  has  been  designed  by  specialist  engineers  drawing

experience  from  vehicle  suspension  engineers,  data  acquisition  engineers,  electrical

engineers and software engineers. 

The range of dynamometers offered by SPA operates a direct drive scotch yoke mechanism

which allows a range of sinusoidal inputs to be configured. The dyno features an offset crank

to convert rotational movement into linear movement at the input shaft. The offset can be

configured to produce a range of amplitudes (Options: 12.5mm, 25.0mm, 37.5mm, 50.0mm,

62.5mm,  75.0mm,  87.5mm  and  100.0mm).  When  a  predefined  offset  is  selected  this

determines the amplitude and the control  software can vary the frequency of  the motor

rotation to control the peak velocity achieved during the cycle.
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The peak velocity is determined by the following equations: 

Peak Velocity = Radius (m) x Angular Velocity (rad/s)

Angular Velocity = 2 x π x Motor Frequency (Hz)

The scotch yoke mechanism allows a cost efficient method to generate a consistent test

input compared to test machines which require a sophisticated control  system to control

linear displacements. The test machine allows the control of the motor frequency to vary the

peak test velocity for a given stroke setting. The stroke of the machine can be changed

manually to achieve a different range of test velocities.
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2.1 BTP-2000 BENCHTOP 2.2Kw 50mm Stroke

2.2 BTP-4000 BENCHTOP 2.2kW 100mm Stroke

2.3 PSD-04 100mm Stroke

2.4 BI-99-2.2kW 100mm Stroke

2.5 BI-99-5.5kW 100mm Stroke

2.6 BI-99-7.5kW 100mm Stroke

3 Getting Started

3.1 Connecting to the Electrical Supply

After unpacking your Dyno it will be necessary to connect it to the electrical supply and your

computer. For 230/240v supply use either a 20amp type A(pulse-current sensitive)or 20amp

type B(universal-current sensitive) RCCB,The Dyno is supplied with a standard 13 amp plug

for use in the United Kingdom. For other parts of the world this should be removed and the

appropriate plug fitted. The Dyno should be supplied with 200/220 volts 50/60 Hz a.c and

has an inrush current of 20 amps but when running should draw closer to 10 amps.    This

machine MUST be earthed  .

 

3.2 Installing the Software

 Your next task is to install the Dyno software onto your computer, if we have supplied the

computer with the Dyno this will already be done.

 To install your software follow these steps:-

Either using the disk provided or software downloaded 

From the internet (www.spa-uk.co.uk) click on the zip 

File and select an appropriate place to extract the file.

When the file has extracted, double click on the setup icon 

Commence the installation selecting your preferred installation path.
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Follow  the  on-screen  instructions  and  upon  the  completion  of  the  installation  it  is

recommended that you restart your computer.

3.3 Connecting the PC to the Dyno

 

3.4 Configuring the System

3.4.1 Software Settings

4 Shock Dynamometer

5 Testing Shock Absorbers

5.1 Configuring the Dyno

5.2 Mounting the Shock
The dyno is supplied as standard with x2 clevises of 0.625” Width and x2 pins of  0.500”

which will accept a wide variety of standard racing shocks. 

Notes: 

1. Ensure dyno is parked at Bottom Dead Centre before mounting shocks

2. Ensure shock has sufficient stroke available for desired test procedure

Procedure:

1. Thread the clevises onto the load cell and input shaft.
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2. Un-clamp and raise the crossbar to allow clearance to fit  the shock and then re-

clamp.

3. Fit the shock to the upper clevis (on the load cell) first and slide the pin through the

bearing – rotate the clevis to lock down.

4. Un-clamp the crossbar and lower the shock to the lower clevis. Slide the pin through

the bearing and rotate the clevis to lock down. 

5. Compress the shock slightly  using the crossbar to ensure the piston assembly is

manoeuvred away from the shaft bearing to prevent internal collisions during testing.

6. Once the desired position is achieved firmly secure the crossbar.

7. Affix temperature sensor to shock body.

8. Set shock adjusters to desired settings.

5.3 Creating the Test Method

5.3.1 Test Considerations

To determine the type of test to create first we must consider:

1. The maximum speed to be tested.

2. The minimum speed to be tested.

3. The number of data points required.

4. The temperature at which the test is to be conducted.

The  maximum  speed  depends  on  the  type  of  shock  and  the  speeds  which  are  to  be

expected during service - along with any noted points of interest. 

The minimum speed chosen must be such that it produces an adequate curve of the shock –

generally the lowest possible speed is chosen. The lowest possible speed however depends

on the low speed performance of the dyno – the motor must rotate to generate a speed

signal. If the motor is rotating very slowly then the controller will not receive a signal to permit

proper control of the motor speed.

The number of data points depends on the level of information required from the shock but it

should be sufficient to generate an adequate curve. Sometimes data points are increased

around the low speed regions of the shock curve to enhance the curve in this area. 

6



The temperature  at  which  the shock is  to  be tested can be determined from in-service

temperature or by a pre-set laboratory temperature. It should be noted that during a test the

temperature  of  the  shock  will  increase  –  this  should  be  considered  when  setting  the

maximum speed and also the amount of data points around this maximum.

5.3.2 Test Recommendations

The maximum speed required from the test will determine the stroke that the shock will be

tested at. Increasing the stroke of the dyno will increase the maximum test velocity that can

be achieved.  The maximum velocity for each stroke is governed by the maximum motor

frequency – the peak velocities reached will be when the motor can operate at its maximum

frequency. However, when testing a shock the motor is under load and depending on shock

stiffness the maximum frequency may not be reached. Therefore the following guidelines are

recommended:

 12.5mm / 0.5” Stroke – Low speed test – up to 50mm/s or 2in/s

 25mm / 1.0” Stroke – Basic calibration test – up to 300mm/s or 12in/s

 50mm / 2.0” Stroke – Increased calibration test – up to 500mm/s or 20in/s

 100mm / 4.0”  Stroke – High speed tests – up to 1500mm/s or 60in/s

The  maximum figures  represent  what  the  dyno  can  achieve  when  under  no  load.  The

capability of the dyno to reach these speeds is dependent on the maximum output of the

motor  and  the  stiffness  of  the  shock.  For  simple  calibration  tests  (validating  valving,

matching shocks) it is recommend to test this on 25-50mm (1.0-2.0”) stroke – a 2.2kW motor

will  be ample for performing these tests. For increased speeds it  is recommended that a

dyno with a more powerful motor be chosen.

5.3.3 Creating the Sample Method – Shock

The sample method is the set of  procedures and operating conditions the shock will  be

tested at. There is no industry standard for testing shock absorbers – it is entirely up the user

and dependent on the information they require type of shock absorber and its application. It

is  recommended  that  the  shock  be  tested  at  speeds  which  represent  its  in-service

environment and normal usage – i.e. a sports car shock will not see as high velocities as an

off-road shock.

7



It must also be noted that the test cannot replicate the real-life operating conditions of the

shock – it  is  only a means to validate stiffness, investigate valving changes and also to

calibrate and match multiple shocks.

5.3.4 Sample Method – New

On the main menu bar select Sample>Method>New.

 New>Allows creation of new test method

 Edit>Allows user to edit an existing test method

5.3.5 Sample Method – Name
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The name entered here will be the file name for the .mtd method file.

5.3.6 Sample Method – Pre-run

         

The shock can be cycled at a constant speed to reach a pre-defined temperature. Select a 

speed appropriate for the shock – a soft shock will require longer to heat up than a stiff 

shock so select an appropriate warm up speed based on shock stiffness. The target 

temperature is either the in-service temperature or a pre-defined temperature that all tests 

are conducted at.

9



5.3.7 Sample Method – Component

The dyno has the capability to test both shocks and springs – select the appropriate

component. For this example it is ‘shock’.

5.3.8 Sample Method – Speed type

There are different speed options for test methods:

 Single Speed – Runs a single cycle at a pre-defined peak velocity
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 Multiple  Speed (PV) – Runs a multi-step test  at  various  pre-defined peak

velocities

 Scatter Plot – Runs a single speed test and displays a scatter plot



The most common test method is the Multiple Speed (PV). This allows the user to view

results in all graph formats from a single results file.
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5.3.9 Sample Method – Speeds

Enter the appropriate Start and End Speeds. By selecting ‘equal speed steps’ and entering a

Speed Step value the software will calculate the individual speed steps automatically.

Select ‘Use Step Table’ if you wish to enter specific speed steps of particular interest within

the start and end speeds – this allows the user to use steps of varying magnitude.

5.3.10 Sample Method - Gains
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The gains define the operating resolution of the sensors (displacement, velocity, force) on

the dyno. The resolution can be enhanced when the dyno is operating in specific conditions.

Load Gain: 

(x1) +/- 1500kg (3300lbs) (x4) +/- 375kg (826lbs)

Velocity Gain: 

(x1) 0<12in/s (x0.25) 0<60in/s (x5) 0<2in/s

Position Gain:

(x1) 0<4” Stroke (x4) 0<1” Stroke

5.3.11Sample Method - Sample

The number of cycles determines how many cycles of data is taken at each speed step. 

The sample time determines the sampling rates. Manual sampling allows the user to select a

constant sample time – 1000Hz would be a sample time of 0.001s (1/1000). When setting

high manual sample rates (up to 10,000Hz) a larger amount of data is recorded resulting in

larger file sizes. Also higher sampling rates will pick up a lot more noise in the traces. During

high velocity testing a high sampling rate is required to ensure no data is missed – however

at  low velocities  a high sampling rate will  ‘over  sample’ and pick up too much data.  To

overcome this the ‘automatic’ feature can be used – this allows a sample time to be defined

rather than a rate. 
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As standard 1000 samples are then taken per cycle of the test. This figure can be edited in

Configure>Defaults>Misc and then edit the ‘Normal Sample Size’.
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5.3.12 Sample Method – Post-run

Select the appropriate park position (normally BDC) and a park speed – only a low velocity is

required for parking. A cool down cycle can also be selected to cycle the shock at a low 

temperature to allow it to cool.

Plotting a graph after each cycle of run will plot a final graph of the result of the test, display 

this graph for 5 seconds and then re-run the test. This allows for any changes to be made to 

a shock and then quickly re-tested.

Click ‘Finish’ to save the test method. Test methods are saved as .mtd files in the Dyno6 

folder on the C: Drive (this location can be changed).

5.4 Conducting the Test

With the shock mounted and the test method defined the test is now ready to be performed.

Note: Ensure dyno is parked in correct position!
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5.4.1 Starting the Test

Create a new data document File>New>Data Document. All traces will be saved within this

file.
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The test can be started by three methods:

1. Sample>Start

2. Start Sampling Shortcut

                                                

3. Right Click on Data Document and then Start Sample
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5.4.2 Selecting the Method

The current selected method will  be displayed – if  this is not the correct test method an

alternative can be chosen. There is also the option for running multiple test methods.

5.4.3 Trace Information

Enter trace names and information in the table. The load cell must be zeroed before the test

is conducted. There will be a positive force due to the gas pressure of the shock – zeroing

18



the load cell removes the gas pressure force from the test so that only the hydraulic damping

force is being tested.

Note:  Ensure  the  test  area  is  free  from obstructions,  all  personnel  are  clear  of  the

machine and the shock is safely secured before testing. Also ensure the condition of the

shock is such that it is fit to be tested!

5.4.4 Aborting the Sample

*Aborting Sample Method*

*The sample method can be aborted using the above icon*

If there are any issues or safety concerns whilst conducting the test use the ‘Stop Sample’

icon on the software toolbar. It is recommended to run the dyno manually starting from a low

speed to check the condition of a shock before performing any high speed tests.

5.5 Reviewing the Results

When the test is finished the results can be viewed in the various graphical displays along

with tabular displays. 

These can be accessed from the toolbar shortcuts:

Or from the drop down menu:
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5.5.1 Force v Displacement (egg graph)

This is the most popular of the force/displacement graphs. When selected plots the force on

The y Axis and the displacement on the x Axis. 

The example above shows a damper which has been tested on a stroke of 25.4 mm/ 1 inch. 
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The midpoint of the stroke is taken as zero for displacement and produces the familiar graph
shape. This also means that the shaft speed is fastest at zero displacement and generally is 
where the maximum forces occur(as above). By convention (not worldwide) the bump forces
are shown as positive and the rebound  as negative.

5.5.2 Force v Velocity Graph,  

The above graph shows the true force/velocity  gained from a single  sample.  It  is  worth

nothing when the velocity is zero, which occurs when the direction of stroke changes as the

force is not at zero. This is because it is a dynamic system and oil within the shock is still in

motion. If allowed to stop, the system will return to its rest state and force and force slowly

return to zero. In essence the hysteresis of the damper is shown by the area within the loop

made by the trace. 
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As you can see from the above graph when displaying the result of a peak velocity run

where several samples are shown simultaneously the image may become unclear around

the zero velocity.

5.5.3 Force v Velocity Cross Graph,
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This is the same force/velocity information used in the last graph but displayed in a different 

way. This time the rebound velocities are given as negative values.

This  graph  has  the  advantage  that  when  taking  a  peak  velocity  run  involving  several

samples the display around zero is much clearer. 
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5.5.4 Force v Average Velocity Graph

This graph shows the Force v Average Velocity for the test. Please note this graph will not

start at zero as the shock is constantly being tested and passes through the zero point – as

a result of this there will still be a pressure difference across the main piston in the shock

resulting in a force at the shaft at zero velocity.
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5.5.5 Force v Peak Velocity Graph,

As mentioned earlier the peak velocity graph is a result of several samples used together. 
The damper is sampled from a starting speed and then at intervals that you have chosen. All
of these samples are displayed in the other graphs and are treated as a single trace for 
display purposes. The peak velocity trace is made up of the force exerted as the damper 
achieves its peak velocity in the bump and rebound. The trace results from drawing lines 
through the recorded forces at the various speeds the were chosen by the operator.

The use of the peak velocity graph adds another difficulty for the user. You must take enough

samples  to  provide  an  accurate  graph  but  at  the  time  not  so  many  as  may  change

characteristics of the damper by heating. This can only come by personal experience in the

tests you are making. 
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5.5.6 Force and Displacement / Time,

This graph displays the same information as the first (egg) graph but now against time in

seconds. This is an extremely useful graph where problems have been encountered with a

damper. The fact that the force and displacement information are displayed separately aids

fault finding.

The above graph is a result of a single trace and shows that the force is out of phase with

the displacement by 90 degrees. The example below shows a result from a peak velocity

run.
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5.5.7 Force and Velocity/Time,

As with the previous example this graph takes the same information displayed in another 
graph, this time force and velocity, and displays them against time in seconds. It graphically 
shows how the force is in phase with the velocity with the maximum velocity producing the 
maximum force.

The graph below shows the result of a peak velocity run where samples are taken 
successively. It can be seen from this and the previous page that these peak velocity runs 
have been taken by accelerating to the maximum speed and then decelerating as required. 
This is not a requirement of the software but is has been shown to produce the best results.
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5.5.8 Accelerating Bump, Decelerating Rebound vs Velocity,

The next two tabs are accelerating bump, decelerating rebound vs velocity and decelerating 
bump, accelerating rebound. These graphs basically split the force velocity graph in half. 
These graphs are mainly used for finding very minor faults/ problems.
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5.5.9 Decelerating Bump, Accelerating Rebound vs Velocity
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5.5.10 3 D graph options 

 
 There are three choices of data to use to create a 3d graph:

 1 Force Vs Velocity Vs Time

 2 Force Vs Displacement Vs Time (shown below)

 3 Force Vs Displacement Vs Velocity 
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5.5.11 Data Tables

Data tables can be accessed from the Graphs> on the main menu and are represented by

the following icons:

The data can also be viewed in various table formats – from the raw data recorded during

the test, a user defined step input and also the data for the Force v Peak Velocity Graph.
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Understanding the Test Results

To fully understand the meaning of the test results you must fully understand how the shock 
has been tested and what is actually happening inside the shock to produce these results.

5.5.12  Force v Displacement Graph

The force displacement graph displays the force achieved at a given displacement at a given

test stroke and velocity. The dyno uses a scotch yoke direct drive system where the motor

turns a crank and the sliding yoke coverts this into linear movement at the dyno shaft. By

breaking down the crank movement into four quadrants it is easier to understand what the

shock is doing and the dyno is measuring.
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5.5.12.1  Quadrant One

This is the beginning of the compression stroke.  Where the graph crosses the zero line

(pounds) in quadrant one is the start of the compression stroke and approximately the first

½” of displacement is formed with the low speed bleed bypass. When the shaft reaches a

certain velocity, the low speed bleed bypass chokes off and the compression valve stack

begins to react.

5.5.12.2  Quadrant Two

This quadrant begins with compression valve stack open. Where the graph crosses the zero 
line (inches) in quadrant two is the maximum force produced by the compression valving. As 
the shock approaches the full compression point, the compression valve stack begins to 
close as it approaches the rebound movement.

5.5.12.3  Quadrant Three

This quadrant begins with the shock at full compression and the compression valve stack

closed.  Where  the  graph  crosses  the  zero  line  (pounds)  in  quadrant  three  begins  the

rebound  stroke.  Approximately  the  first  ½”  displacement  is  formed  with  relation  to  the

rebound bleed through the shaft and the jet. When the shaft reaches a certain velocity, the

bleed shuts off and the rebound valve stack begins to react.
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5.5.12.4  Quadrant Four

This quadrant begins with the rebound valve stack open. Where the graph crosses the zero

line  (inches)  in  quadrant  four  is  the  maximum rebound  force  produced  by  the rebound

valving. As the shock approaches its full extension point, the rebound valve stack begins to

close as it approaches the compression movement. At this point the cycle starts over again

in quadrant one. 

5.5.12.5  Force v Velocity Graphs

The Force v Velocity  graphs represent  the shocks behaviour  in  relation to velocity. This

behaviour can be altered using adjuster settings or changing the internals of the shock.
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6 Testing Linear Springs
The shock dynamometer can also be used to test and record data from springs to allow the

Force v Displacement relationship and Spring Rate to be determined.

A spring testing kit  is available which allows a standard range of race car springs to be

tested.

6.1 Configuring the Dyno

For testing linear springs it is recommend setting the dynamometer to a 25mm Stroke.

Go to Configure>Settings and select the appropriate units and strokes. Select ‘Hz’ for Dyno

Speed.

6.2 Mounting the spring

First of all ensure the dyno is parked at bottom dead centre.

Using the spring adaptors provided select the appropriate adaptor for the spring – in this

case for a 2.25” ID Spring.
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Fit the spring platform adapters onto the load cell and input shaft. Use a locking nut on the

load cell to secure the adapter - avoid tightening the spring platform against the load cell as

this can distort the load cell reading.

Next fit the spring – needle thrust bearings are recommended to allow the spring to rotate as
it compresses.

                       

Lower the crossbar until it touches the spring. A small amount of preload is required to locate
the spring and prevent it from becoming loose. 

Note: Any spring preload is accounted for when you zero the load cell at the start of the test.
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6.3 Creating the Test Method

6.3.1 Sample Method - New

Select Sample>Method>New to create a new sample method file (.mtd file).

6.3.2 Sample Method - Name

Enter a name in the text box – this will be the file name that the method file is saved under.

6.3.3 Sample Method – Pre-run
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Define any pre-run conditions- For a metallic spring no warm up is required but for testing air

springs temperature parameters can be defined.

6.3.4 Sample Method - Components

Select ‘spring’ as the type of component to be tested.

6.3.5 Sample Method - Speeds
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Select  the speed control  –  for  the  spring test  only  the  ‘manual  speed  control’  option  is

selected. Enter 0.25Hz for the speed.

6.3.6 Sample Method - Sample

The number of cycles for a spring test is pre-defined as 1. The Sample time can be selected

to be Automatic (1000 samples per revolution) or a Manual sample time can be entered.
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6.3.7 Sample Method – Post-run

The post run requirements can be entered here. Tick ‘Park after run’ and set the parameters

to ‘BDC’ and a Park speed of 0.25Hz.

Click ‘Finish’ to save the test method.

6.4 Conducting the Test
With the spring mounted and the test method defined the test is now ready to be performed.

Note: Ensure dyno is parked in correct position!

6.4.1 Starting the Test

Create a new data document File>New>Data Document. All traces will be saved within this

file.
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The test can be started by three methods:

1. Sample>Start

2. Start Sampling Shortcut Icon

                                                

3. Right Click on Data Document and then Start Sample

6.4.2 Sample Setup - method
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6.4.3 Sample Setup - Traces
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Enter trace names and information in the table. The load cell must be zeroed before the test

is conducted. There will be a positive force due to the gas pressure of the shock – zeroing

the load cell removes the gas pressure force from the test so that only the hydraulic damping

force is being tested.

Note: Ensure the test area is free from obstructions, all personnel are clear of the

machine and the shock is safely secured before testing. Also ensure the condition of

the shock is such that it is fit to be tested!

Click ‘Finish’ to begin the test.

6.4.4 Dyno Speed

To set  the dyno speed ensure the main control  switch is in the ‘0’ position on the dyno

control panel. Switch the dyno control switch from PC Control to Manual Control and slowly

increase the dyno speed to 0.25Hz. The dyno speed can be viewed in the lower left of the

software.
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Once a speed of 0.25Hz has been reached select ‘OK’ and the dyno will start recording data.

The dyno will  then record data for one full cycle for the test – the information bar on the

lower left of the screen will then show the progress of the test.

Once the data has been collected the test will finish and the dyno will park. When ‘Parking’ is

displayed in the information bar switch the PC back to Manual Control to allow the PC 

control the dyno to the park position. 
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If the dyno is not switched to PC Control quick enough then the dyno will not park itself 

under PC Control – the user must then park the dyno manually using the software.

6.4.5 Aborting the Sample

*Aborting Sample Method*

*The sample method can be aborted using the above icon*

If there are any issues or safety concerns whilst conducting the test use the ‘Stop Sample’

icon on the software toolbar. It is recommended to run the dyno manually starting from a low

speed to check the condition of a spring before performing any tests.

6.5 Reviewing the Results
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The data recorded shows the full cycle of the spring – when it has been compressed and

then uncompressed. This allows the hysteresis of the spring to be shown.

The rate of the spring is the gradient of this graph – it is recommended to calculate this using

the figures obtained from the results.

Spring Rate = (Max Force – Min Force) / (Max Displacement – Min Displacement)

(668lbs) / (0.984in*) = 678lbs/in

*Spring was tested on a metric machine with 25mm stroke
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